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Thank you for purchasing an Omega FMA-2600A Series Gas Flow Controller.

Please take the time to read the information contained in this manual. This will
help to ensure that you get the best possible service from your instrument. This
manual covers the following Omega instruments:

FMA-2600A Mass Gas Flow Controllers
FMA-LP2600A Low Pressure Drop Mass Gas Flow Controllers
FMA-2600A-LSS Mass Gas Flow Controllers

FMA-2600A-LSS Flow Controllers are for use with certain aggressive gases
(see page 67)

FMA-2600A-P Mass Gas Flow Controllers

FMA-2600A-P Flow Controllers have an integrated shut-off valve and are built
for use with applications that require tight shut-off (see pages 30 and 65).

Unless otherwise noted, the instructions in this manual are applicable to all of
the above instruments.

Full specifications for each device can be found on pages 56 through 71.

9 Please contact Omega at 800-826-6342 if you have any questions
regarding the use or operation of this device.
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GETTING STARTED

Power Jack

Control Valve 8 Pin MiniDIN

Display Screen

Inlet Connection Port

Outlet Connection Port

Flow Direction Arrow

Small Valve Mass Flow Controller shown with an upstream valve configuration and
connection port fittings

Large Valve Mass Flow Controller shown with a downstream valve configuration and
connection port fittings
MOUNTING

FMA-2600A Gas Flow Controllers have holes on the bottom for mounting to flat
panels. See pages 56 - 71.

Small valve controllers can usually be mounted in any position.

Large valve controllers should be mounted so that the valve cylinder is vertical
and upright. Mounting a large valve controller in another position increases the
risk of leakage when the controller is being held closed by the spring force.

No straight runs of pipe are required upstream or downstream of the controller.



PLUMBING

9 Your controller is shipped with plastic plugs fitted in the port openings.
To lessen the chance of contaminating the flow stream do not remove
these plugs until you are ready to install the device.

Make sure that the gas will flow in the direction indicated by the flow arrow.

Standard FMA-2600A Gas Flow Controllers have female inlet and outlet port
connections. Welded VCR and other specialty fittings may have male ports.

The inlet and outlet port sizes (process connections) for different flow ranges
are shown on pages 56 - 71.

Controllers with M5 (10-32) ports have O-ring face seals and require no sealant
or tape. Do not use tape with welded or o-ring fittings.

For non-M5 (10-32) ports use thread sealing PTFE tape to prevent leakage
around the port threads.

Do not wrap the first two threads. This will minimize the possibility of getting
tape into the flow stream and flow body.

Do not use pipe dopes or sealants on the process connections as these
compounds can cause permanent damage to the controller should they get
into the flow stream.

When changing fittings, carefully clean any tape or debris from the port threads.
We recommend the use of in-line sintered filters to prevent large particulates
from entering the measurement head of the instrument. Suggested maximum
particulate sizes are as follows:

5 microns for units with FS flow ranges of 0-1 sccm or less.
20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

PRESSURE
Maximum operating line pressure is 145 psig (1 MPa).

If the line pressure is higher than 145 psig (1 MPa), use a pressure regulator upstream
from the flow controller to reduce the pressure to 145 psig (1 MPa) or less.

MAY CAUSE PERMANENT DAMAGE TO THE SOLID-STATE DIFFERENTIAL

f CAUTION! EXCEEDING THE MAXIMUM SPECIFIED LINE PRESSURE
PRESSURE TRANSDUCER.




POWER AND SIGNAL CONNECTIONS

Power can be supplied to your controller through either the power jack or the 8 pin
Mini-DIN connector.

An AC to DC adapter which converts line AC power to DC voltage and current as
specified below is required to use the power jack.

Small Valve controllers require a 12-30Vdc power supply with a 2.1 mm female
positive center plug capable of supplying 250 mA. NOTE: 4-20mA analog output
requires at least 15 Vdc.

Large Valve controllers require a 24-30 Vdc power supply with a 2.1 mm female
positive center plug capable of supplying at least 750mA.

Standard 8 Pin Mini-DIN Pin-Out

Pin | Function Mini-DIN
cable color
1 | Not Connected (or optional 4-20mA Primary Output Signal) Black
) Static 5.12 Vdc [or optional Secondary Analog Output (4-20maA, Brown

5Vdc, 10Vdc) or Basic Alarm]
3 | Serial RS232RX / RS485(-) Input Signal (receive) Red
Meters = Remote Tare (Ground to Tare)

4 Controllers = Analog Set-Point Input Orange
5 | Serial RS232TX / RS485(+) Output Signal (send) Yellow
6 |0-5 Vdc (or optional 0-10 Vdc) Output Signal Green
7 | Power In (as described above) Blue

8 | Ground (common for power, communications and analog signals) Purple

Note: The above pin-out is applicable to all the flow meters and controllers with the
Mini-DIN connector. The availability of different output signals depends on the options
ordered. Optional configurations are noted on the unit’s calibration sheet.

CAUTION! DO NOT CONNECT POWER TO PINS 1 THROUGH 6 AS PERMANENT
DAMAGE CAN OCCUR!

9 It is common to mistake Pin 2 (labeled 5.12 Vdc Output) as the standard 0-5 Vdc
analog output signal. In fact Pin 2 is normally a constant 5.12 Vdc that reflects
the system bus voltage and can be used as a source for the set-point signal.

DB15 pin-outs see pages 73 to 79.




INPUT SIGNALS

Analog Input Signal

Apply analog input to Pin 4 as shown on page 8.
For DB15 pin-outs see pages 73 to 79.

Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input
signal to pin 4, with common ground on pin 8. The 5.12 Vdc output on pin 2 can
be wired through a 50K ohm potentiometer and back to the analog input on pin
4 to create an adjustable 0-5 Vdc input signal source as shown below.

0-5Vdc

5.12 Vdc

50 KOhm
Potentiometer

Simple method for providing set-point to controllers

Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be
applied to pin 4, with common ground on pin 8.

Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be
applied to pin 4, with common ground on pin 8.

NOTE: This is a current sinking device. The receiving circuit is essentially a 250
ohm resistor to ground.

NOTE: 4-20mA output requires at least 15 Vdc power input.

SYSTEMS, AS THIS WILL DESTROY PORTIONS OF THE CIRCUITRY AND VOID
THE WARRANTY. IF YOU MUST INTERFACE WITH EXISTING LOOP POWERED
SYSTEMS, ALWAYS USE A SIGNAL ISOLATOR AND A SEPARATE POWER SUPPLY.

f CAUTION! DO NOT CONNECT THIS DEVICE TO “LOOP POWERED"”




RS232 / RS485 Digital Input Signal

To use the RS232 or RS485 input signal, connect the RS232 / RS485 Output
Signal (Pin 5), the R$232 / RS485 Input Signal (Pin 3), and Ground (Pin 8) to your
computer serial port as shown below. (See page 30 for details on accessing

RS232 / RS485 input.)

8 Pin MiniDIN Cable End 8 Pin MiniDIN Connector
9 Pin Serial Connection 8 Pin MiniDIN Connection
Pin Function Function Pin
5 Ground Ground 8
3 Transmit Receive 3
2 Receive Transmit 5

DB9 to Mini-DIN Connection for R$232 / RS485 Signals

10



OUTPUT SIGNALS
RS232 / RS485 Digital Output Signal

To use the RS232 or RS485 output signal, it is necessary to connect the R$232 /
RS485 Output Signal (Pin 5), the R$232 / RS485 Input Signal (Pin 3), and Ground
(Pin 8) to your computer serial port as shown on page 8. (See page 31 for
details on accessing RS232 / RS485 output.)

Standard Voltage (0-5 Vdc) Output Signal

FMA-2600A flow controllers equipped with a 0-5 Vdc (optional 0-10 Vdc) will
have this output signal available on Pin 6. This output is generally available in
addition to other optionally ordered outputs. This voltage is usually in the range
of 0.010 Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is
linear over the entire range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your controller was ordered with a 0-10 Vdc output signal, it will be available

on Pin 6. (See the Calibration Data Sheet that shipped with your controller to
determine which output signals were ordered.) This voltage is usually in the range
of 0.010 Vdc for zero flow and 10.0 Vdc for full-scale flow. The output voltage is
linear over the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your controller was ordered with a 4-20 mA current output signal, it will

be available on Pin 1. (See the Calibration Data Sheet that shipped with your
controller to determine which output signals were ordered.) The current signal
is 4 mA at 0 flow and 20 mA at the controller’s full scale flow. The output
current is linear over the entire range. Ground for this signal is common on Pin
8. (Current output units require 15-30Vdc power.)

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See
the Calibration Data Sheet that shipped with your controller to determine
which output signals were ordered.) This output may be a 0-5 Vdc, 0-10 Vdc, or
4-20 mA analog signal that can represent any measured parameter. With this
optional output, a controller could output the mass flow rate (0-5 Vdc on pin 6)
and the absolute pressure (0-5 Vdc on pin 2).

SYSTEMS, AS THIS WILL DESTROY PORTIONS OF THE CIRCUITRY AND VOID
THE WARRANTY. IF YOU MUST INTERFACE WITH EXISTING LOOP POWERED
SYSTEMS, ALWAYS USE A SIGNAL ISOLATOR AND A SEPARATE POWER SUPPLY.

f CAUTION! Do NOT CONNECT THIS DEVICE TO “LOOP POWERED"”

11
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CAUTION! Do NOT CONNECT THIS DEVICE TO “LOOP POWERED"”
SYSTEMS, AS THIS WILL DESTROY PORTIONS OF THE CIRCUITRY AND VOID
THE WARRANTY. IF YOU MUST INTERFACE WITH EXISTING LOOP POWERED

SYSTEMS, ALWAYS USE A SIGNAL ISOLATOR AND A SEPARATE POWER SUPPLY.

Purple (Ground)

Red

Yellow

Purple

h

Red

Yellow

Purple

Red

Yellow

e 9

Unit C

® @ o ©

Female Serial Cable Front

Typical Multiple Device (Addressable) Wiring Configuration

9 The easiest way to connect multiple devices is with a Multi-Drop Box

(see page 54).
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Information for Omega TFT (Color Display) Instruments

Omega TFT (color display) instruments have a high contrast back-lit LCD display.
TFT instruments operate in accordance with Omega standard operating instructions
for our monochrome menus and displays with the following differences.

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating
under normal conditions.

RED: The color of a parameter is displayed in red when operating
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the
monochrome display.

LCD Contrast:

LCD contrast is ranged from 0 to 11 on color displays with 11 being the greatest
contrast.

Display On/Off:

Pushing the button under the Omega name will turn the device display on or
off. This feature is not available on monochrome displays.

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Omega TFT (color display) meters,
gauges and controllers only. All other operating specifications are shown in

the Technical Data page for standard Omega instruments. All standard device
features and functions are available and operate in accordance with the Omega
operating manual provided with the device.

Specification Meter or Small Valve Large Valve
Gauge Controller Controller
Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vvdc 290 mA @ 12Vdc 780 mA @
70 mA @ 24Vdc 200 mA @ 24Vdc 24vdc

13



DISPLAYS AND MENUS

The device screen defaults to Main display as soon as power is applied to the controller.
Note: See page 28 to rotate the display 180°.

Main

The Main display shows pressure,
D D temperature, set-point, volumetric flow
PSIA °C

SETPT and mass flow.

+13.60 +21.58 8.00d

Pressing the button adjacent to a
+B.EB glcr_crq para m.eter wiI'I make that parameter
the primary display unit.
By hitting the MENU button at the
R bottom right of the screen you will
enter the Select Menu display.

If your controller was ordered with the
Totalizer option (page 52), pushing the

TR eita . TOTAL button once will bring up the

Totalizing Mode display. Pushing MENU

EB123.45 will bring up the Select Menu display.

REMAIN _ RESET

Select Menu

From Select Menu you can change
the selected gas, interact with
your RS232 / RS485 settings, read
manufacturer’s data or access the
control set-up display.

Push MAIN to return to the Main display.

GAS CONTROL
SELECT SETUP MAIN

14



This mode defaults on power up, with
mass flow as the primary displayed
parameter.

°C SETPT ; ; ;
. .50 The following parameters are displayed in

the Main mode.

SCCM Gas Absolute Pressure: This sensor
+B EE Air references hard vacuum and reads
. incoming pressure both above and below
local atmospheric pressure. This parameter
o is moved to the primary display by pushing
the button above PSIA.

The engineering unit associated with
absolute pressure is pounds per square
inch absolute (psia). This can be converted
to gage pressure (psig) by subtracting local atmospheric pressure from the
absolute pressure reading:

PSIG = PSIA — (Local Atmospheric Pressure)

Gas Temperature: FMA-2600A flow
controllers measure the incoming
temperature of the gas flow. The
temperature is displayed in degrees Celsius
(°C). This parameter is moved to the primary
display by pushing the button above °C.

Pushing the button again allows you to
select °C (Celsius), K (Kelvin), °F (Fahrenheit)
or °R (Rankine) for the temperature scale.

To select a temperature scale, use the UP
and DOWN buttons to position the arrow in
front of the desired scale.

Press SET to record your selection and
return to the MAIN display. The selected
temperature scale will be displayed on the screen.

Set Point: The set-point (SETPT)is shown in the upper right of the display.
For information on changing the set-point see SETPT SOURCE, page 18.

Volumetric Flow Rate: This parameter is located in the lower left of the display.
It is moved to the primary display by pushing the button below CCM in this
example. Your display may show a different unit of measure.

CONTROLLER, THE MASS FLOW RATE MAY MOMENTARILY EXCEED THE FLOW

MEASUREMENT CAPABILITY (FULL SCALE + 28%) OF THE UNIT. THIS MAY

OCCUR WHEN THE UNIT IS ASKED TO MAKE AN ABRUPT PRESSURE CHANGE.
IF THE OPTIONAL TOTALIZER IS IN USE AT THAT TIME, THE TOTALIZED VALUE
WILL NECESSARILY BECOME INCORRECT. PLEASE RESET THE TOTALIZER IF SUCH AN
‘OVER-FLOW’ CONDITION HAS OCCURRED.

f WHEN USING A MASS FLOW CONTROLLER AS AN ABSOLUTE PRESSURE

15



Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a

standard temperature and pressure (typically 14.696 psia and 25 °C).

This parameter is located in the lower middle of the display. It can be moved to

the primary display by pushing the button below SCCM in this example. Your

display may show a different unit of measure preceded by the letter S.

> To get an accurate volumetric or mass flow rate, the gas being measured
must be selected. See Gas Select, page 22.

MENU: Pressing MENU switches the screen to the Select Menu display.

= volumetric overrange, POV = pressure overrange, TOV = temperature

overrange) flashes when a measured parameter exceeds the range of the

sensor. When any item flashes, neither the flashing parameter nor the
mass flow measurement is accurate. Reducing the value of the flashing parameter
to within specified limits will return the unit to normal operation and accuracy.

If the unit does not return to normal operation contact Omega.

f Flashing Error Message: An error message (MOV = mass overrange, VOV

16




SELECT MENU

From Select Menu you can change the selected gas, interact with your RS232 /
RS485 settings, read manufacturer’s data and access the control setup screen.

Press the button next to the desired operation to bring that function to the screen.

OMEGA

MISCL MISC2 Ph 808-826-6342
Fax 2083-359-7788

UNIT ID
A

DEVICE
UNITS MAIN
Manufacturer Data

. Communications Select
Miscellaneous

MFG RS232
DATA COMM

up
>Recent
Standard
Factory Custom
COMPOSER User Mixes

IA T
+13.60  +21.50
Select Menu

+ .1

nAs  CONTROL
SELECT  SETUP MAIN

Bioreactor

Breathing
Chromatography
Fuel

CANCEL SELECT

+@.00 +0.00
SCCM

Gas Select

SETPT LODP SETPT
SOURCE VAR +0.00

FID

Control Setup

An explanation for each screen can be found on the following pages.

17



CONTROL SETUP

Control Setup is accessed by pressing the button below Control Setup on the
Select Menu display. From this screen you can select your set-point source,
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu
display.

Press MAIN to return to the MAIN display

SETPT LOOP SETPT SETPT SOURCE — Pressing the button
SOURCE VAR +0.8

above SETPT SOURCE will allow you to
select how the set point will be conveyed
to your controller.

Use the line-up and line-down buttons
to move the arrow in front of the desired
option. Then press SET.

Press CANCEL to return to the previous
display.

The controller will ignore any set-point
except that of the selected set-point source and it will remember which input is
selected even if the power is disconnected.

Serial refers to a remote digital RS232
/ RS485 set-point applied via a serial
connection to a computer or PLC as

DOWN MODE described in the installation and RS232 /
>ESEILE'DIE FROMT PANEL RS485 sections of this manual.

Front Panel refers to a set-point applied
directly at the controller.

Front Panel input must be selected
prior to changing the set-point at
the device.

CANCEL

Analog refers to a remote analog set-
point applied to Pin 4 of the Mini-DIN
connector as described in the installation
section of this manual. The standard analog input is 0-5 Vdc.

9 To determine what type of analog set-point your controller has, refer to
the Calibration Data Sheet that was included with your controller.

If nothing is connected to Pin 4, and the controller is set for analog control, the

device will generate random set-point values.

NOTE: If your controller has the IPC (Integrated Potentiometer Control) option,

the IPC dial will operate with the ANALOG set-point source selected.

SETPT refers to the set-point. This parameter may be changed using the display
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to
choose the decimal with the arrow and the UP and DOWN buttons to change
the value. Press SET to record your value. Press CLEAR to return to zero.

18



CAUTION! NEVER LEAVE A CONTROLLER WITH A NON-ZERO SET-POINT IF
NO PRESSURE IS AVAILABLE TO MAKE FLOW. THE CONTROLLER WILL APPLY
FULL POWER TO THE VALVE IN AN ATTEMPT TO REACH THE SET-POINT.
WHEN THERE IS NO FLOW, THIS CAN MAKE THE VALVE VERY HOT!

CONTROL SETUP (continued)

LOOP VAR—The selection of what variable
to close the loop on is a feature unique to
FMA-2600A mass flow controllers.

E LU A Pressing the LOOP VAR button on the
Control Setup screen will allow you to
change what variable is controlled.

Use the line-up and line-down buttons

to move the arrow in front of the desired
option.

When the mass flow controller is supplied
with the control valve upstream of the
electronics portion of the system, the unit
can be set to control on outlet pressure
(absolute pressures only) or volumetric
flow rate, instead of mass flow rate.

The change from mass to volume can
DOWN MODE usually be accomplished without much, if
>Ma55 Flow any, change in the P and D settings.

Volumetric Flow
BAbs Pressure

When you change from controlling
9 flow to controlling pressure,
sometimes fairly radical changes
must be made to the P & D variables. See
CANCEL page 20 — PID TUNING.
Contact Omega if you are having
difficulties with this procedure.

ON AUTO / OFF AUTO—refers to the standard auto-tare or “auto-zero” feature.
The auto-tare feature automatically tares (takes the detected signal as zero) the
unit when it receives a zero set-point for more than two seconds.

A zero set-point results in the closing of the valve and a known “no flow”
condition. This feature makes the device more accurate by periodically
removing any cumulative errors associated with drift.

It is recommended that the controller be left in the default auto-tare ON
a mode unless your specific application requires that it be turned off.

19



PID TUNING

SETPT
SOURCE

> F'D F'ID
PDZIPID

CANCEL

LOoP
VAR

DOWN

I
BEEEE

LOoP
TYPE

SETPT
+@.a

MODE

D
B2361

MAIN

PID Values determine the performance

and operation of your proportional control
valve. These terms dictate control speed,
control stability, overshoot and oscillation.
All units leave the factory with a generic
tuning designed to handle most applications.
If you encounter issues with valve stability,
oscillation or speed, fine tuning these
parameters may resolve the problem.
FMA-2600A controllers allow you to adjust
the Proportional, Integral and Differential
terms of the PID control loop.

To change the PID loop parameters, push
the button below PID.

Press LOOP TYPE. Then use the LN-UP and
LN-DN buttons to select the appropriate
PID control algorithm. Press SET.

See the following page for descriptions
of the PID Loop Types (PID Control
Algorithms).

P refers to the Proportional term of the
PID loop.
I refers to the Integral term of the PID loop.
D refers to the Differential term of the PID
loop.
Press P, | or D. Then use SELECT to choose
the decimal with the arrow and the UP
and DOWN buttons to change the value.
Press SET to record your value. Press
CLEAR to return to zero.
Before changing the P, | or D
9 parameter, please record the initial
value so that it can be returned to
the factory setting if necessary.
Valve tuning can be complex. If you
would like assistance, please contact
Omega for technical support.

20



The PD algorithm is the PID algorithm used on most FMA-2600A controllers.

It is divided into two segments:

The first compares the process value to the set-point to generate a proportional

error. The proportional error is multiplied by the ‘P’ gain, with the result added

to the output drive register.

The second operates on the present process value minus the process value during

the immediately previous evaluation cycle. This ‘velocity’ term in multiplied by

the ‘D’ gain, with the result subtracted from the output drive register.

The above additions to and subtractions from the output drive register

are carried over from process cycle to process cycle, thus performing the

integration function automatically.

Increasing the ‘P’ gain will promote the tendency of the system to overshoot,

ring, or oscillate.

Increasing the ‘D’ gain will reduce the tendency of the system to overshoot.

The PD2I algorithm is a PID algorithm used primarily for high performance

pressure and flow control applications.

It exhibits two basic differences from the PD algorithm that most controllers utilize.
1. Instead of applying a damping function based upon the rate of change of the
process value, it applies a damping function based upon the square of the rate of
change of the process value.

2. The damping function is applied directly to the proportional error term
before that term is used in the proportional and integral functions of the
algorithm. This provides a certain amount of ‘look ahead’ capability in the
control loop.

Because of these differences, you will note the following:

1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations
in pressure controllers. You will know that ‘P’ gain is too high, when the
controller breaks into fast oscillations on step changes in set-point. On flow
controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’
gain results in overshoot and/or slow oscillation. A good starting value for ‘P’
gain is 200.

2. If the unit was originally shipped with the PD2I algorithm selected, the

‘D’ gain value should be left at or near the factory setting because it relates
primarily to the system phase lags. If you are changing from the default
algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges

to the set-point, after the initial step change. Too low a value for ‘I’ gain
shows up as a process value that jumps to near the set-point and then takes
awhile to converge the rest of the way. Too high a value for ‘I’ gain results in
oscillation. A good starting value for the ‘I’ gain is 200.
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GAS SELECT

up DOWN

»Recent
Standard
Factory Custom
Composer User Mixes

Bioreactor
Breathing
Chromatography

PARGE

Gas Select allows you to set your
device to up to 150 standard gases and
mixes. You can also use composer to
program and store up to 20 additional
gas mixes.

Gas Select is accessed by pressing the
button below GAS SELECT on the Select
Menu display.

To select a gas, use the UP and DOWN

Fuel

CANCEL buttons to position the arrow in front of

the desired gas category.
»  Recent: Eight most recent selections
»  Standard: Gases and mixes standard
on earlier Omega instruments (page 37)
»  Factory Custom: Present only if customer
requested gases were added at the factory
»  Composer User Mixes: Gas mixes
programmed by the user (page 23)
DOWN PRGE »  Bioreactor (page 43)
>If::E1'r" »  Breathing (page 44)
02 Concentrator »  Chromatography (page 46)
Pure Corrosive »  Fuel (page 45)
Laser (page 45)
02 Concentrator (page 46)
»  Pure Corrosive* (page 40)
»  Pure Non-Corrosive (page 39)
»  Refrigerant* (page 41)
»  Stack (page 46)
»  Welding (page 42)

Pure Hon-Cortosive
Refrigerant »
Stack »
lelding

CANCEL

Press PAGE to view a new page in the gas category list.

Press SELECT to view the gases in the selected category. Align the arrow with the
desired gas. Press SET to record your selection and return to the MAIN display.
The selected gas will be displayed on the screen.

* Pure Corrosive and Refrigerant gases are only available on FMA-2600A-LSS Series
instruments that are compatible with these gases.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 39 -46 for a full list of gases in each category.
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COMPOSER

Composer allows you to program
and save up to 20 custom gas mixes
containing 2 to 5 component gases

P DOWN found in the gas lists (pages 39-46). The
#Hdd Mix: 28 Free minimum resolution is 0.01%.

Composer is accessed by selecting
Composer User Mixes on the GAS
SELECT display.

Press SET when the arrow is aligned
CANCEL with Add Mix.

Name the mix by pressing the UP and
DOWN buttons for letters, numerals
and symbols.

CHANGE CASE — Toggles the letter
case. Letters remain in selected case
until CHANGE CASE is pushed again.

DOWH HERT
LETTER

Composer Mix name: After naming the mix, press ADD GAS
and select the gas category and the
component gas.

Press SET to save the name.

Select the digit with arrow and adjust
BACK. CHANGE the % with the UP and DOWN buttons.
CANCEL LASE Press set to save. Add up to 4 more
gases as needed. The total must equal
100% or an error message will appear.

GAS OPTNS allows you to adjust the
percentage of the constituents or
delete a gas from the mix. Gas mixes
cannot be adjusted after they have
been saved.

EDIT ADD GAS GAS
MAME OPTHS

Composer Mix: MyGAS

B.86x of Total

BACK.~ CHANGE
CAMCEL CASE
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DOWN SELECT
DIGIT

Percent of Air:

oH.H

BRCK~
CANCEL CLEARR

DOWN SELECT
DIGIT

Percent of He Helium:

28,50

BRCK~
CANCEL CLEAR

CRERTE CREATE
NEW SIMILAR

COMPOSER USER MIX
MyGas

HRS BEEN SRVYED

SELECT
MIKTURE

DOWN SELECT
DIGIT

Percent of Ar Argon:

S8.84

BACK.~
CANCEL CLERR

EDIT ADD GRS GRS
NAME OPTHS

Composer Mix: MyGRS
S Air
36 AR Argon
26 He Helium
1686.688> Total

CANCEL

Once the mix has been saved, you
may press CREATE SIMILAR to
compose an additional mix based
on the mix you have just saved.
This CREATE SIMILAR option is not
available after leaving this screen.

Press CREATE NEW to add a
completely new mix.

Press SELECT MIXTURE to bring the
custom mix onto the MAIN display.
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COMMUNICATION SELECT

Access Communication Select by pressing
the button above R$232 COMM or RS485
COMM on the Select Menu display.

UNE D BAUD Unit ID — Valid unit identifiers are the
letters A-Z and @. The identifier allows
you to assign a unique address to each
device so that multiple units can be
connected to a single RS232 or RS485
computer port.

Press UNIT ID. Use the UP and DOWN
buttons to change the Unit ID. Press SET to
record the ID. Press Reset to return to the
previously recorded Unit ID.

Any Unit ID change will take effect when
Communication Select is exited.

If the symbol @ is selected as the Unit
UNIT ID ID, the device will enter streaming mode
¢ when Communication Select is exited.
See RS232 Communications (page 31) for
information about the streaming mode.

C

Baud - Both this instrument and your
computer must send/receive data at the
BACK RESET A same baud rate. The default baud rate for
this device is 19200 baud.

Press BAUD. Use the UP and DOWN
buttons to select the baud rate that
matches your computer. The choices are
38400, 19200, 9600, or 2400 baud. Press
SET to record the baud rate.

Any baud rate change will not take effect
until power to the unit is cycled.
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MISCELLANEOUS
Miscellaneous is accessed by pressing the MISC button on the Select Menu display.
Next select either MISC1 or MISC2.
MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband.
e PREGE FLou Zero deadband is a value below which the display
BAND AVG RVG jumps to zero. This deadband is often desired to
prevent electrical noise from showing up on the
display as minor flows or pressures that do not
exist. Display Zero Deadband does not affect the
LCD analog or digital signal outputs.

CONTRAST MAIN

ZERO BAND can be adjusted between 0 and
6.3% of the sensor’s Full Scale (FS).
Press ZERO BAND. Then use SELECT to choose
the digit with the arrow and the UP and DOWN
buttons to change the value. Press SET to record
your value. Press CLEAR to return to zero.

DOWN- SELECT Pressure Averaging and Flow Averaging may

be useful to make it easier to read and interpret
E_E rapidly fluctuating pressures and flows. Pressure
and flow averaging can be adjusted between 1
(no averaging) and 256 (maximum averaging).

CANCEL  CLEAR These are geometric running averages where
the number between 1 and 256 can be
considered roughly equivalent to the response
time constant in milliseconds.

This can be effective at “smoothing” high frequency process oscillations such as
those caused by diaphragm pumps.

Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to
return to zero.

Press FLOW AVG. Then use SELECT to choose the
digit with the arrow and the UP and DOWN buttons
to change the value. Press SET to record your value.
Press CLEAR to return to zero.

Setting a higher number will equal a smoother
display.

LCD CONTRAST: The display contrast can be
CAMCEL  RESET adjusted between 0 and 31, with zero being the
lightest and 31 being the darkest. Use the UP
and DOWN buttons to adjust the contrast. Press
SET when you are satisfied. Press CANCEL to
return to the MISC display.
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MISC2 will display as shown at left.

STP/NPT refers to the functions that allow
your selection of standard temperature and
e ROTRTE pressure conditions or normal temperature
and pressure conditions. This feature is
generally useful for comparison purposes to
other devices or systems using different STP
parameters.

The STP menu is comprised of the STP TEMP
and STP PRESS screens.

STP TEMP allows you to select from °C, °F, K
or °R. The arrow position will automatically
default to the currently stored value.

The NTP menu is comprised of the NTP
TEMP and NTP PRESS screens.

Once a selection has been made and recorded
using the SET button, a change acknowledgement

STP STP message will be displayed on screen.
TEMP PRESS

Selecting MAIN will revert screen to the
Main display. If the SET selection is already
the currently stored value, a message
indicating that fact will appear.

STP PRESS enables you to select from a
menu pressure settings. Use the UP/DOWN
or PAGE buttons to view the settings.

The arrow position will automatically default
to the currently stored value.

Once a selection has been made and recorded using the SET button, a change
acknowledgement message will be displayed on screen.

Pressing SET again will revert screen to the Main display. If the SET selection is
already the currently stored value, a message indicating that fact will appear.

DOWN SELEET DOWN SELEET

Tenmperature: °C Pressure: Pad

e NE EEE 111335.H

BACK.~ BACK.~
CANCEL CAMCEL CLERR

STP TEMP Display STP PRESS Display
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DIAG TEST: This diagnostic screen displays
the current internal register values, which
is useful for noting factory settings prior
SCROLL to making any changes. It is also helpful
: AP Sig Tarl : P
Tenp 3ig 25671 for troubleshooting with Omega customer

DP Side 9986 service personnel.

ohe  ers Select the DIAG TEST button from the MISC2

Meter Fun 159 screen to view a list of select register values.
Power Up 32768

BACK MAIN Pressing the SCROLL button will cycle the
display through the register screens. An
example screen is shown at left.

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The
display and buttons will rotate together.

DEVICE UNITS

Press DEVICE UNITS to access menus of
units of measure for each parameter (and
totalizer if so equipped).

Scroll to the desired unit and press select.
Mass Flow .
Volumetric Flow Once selected, you will see the message
?PE‘SSUPE shown below. Verify that all connected
Mo devices expect the change.
Totalizer Tine See pages 47 and 48 for a full list of
available units.

DOWN

DONE SELECT

DOWN PARGE

PRESSING SET WILL
AFFECT DISPLAY
AND SERTAL VALUES

SCCH
Scm3h
Sn3sh
Sn3-d
Sin3sm
SCFH
ML=

CANCEL

VERIFY CONNECTED
SERIAL DEVICES
EXPECT THE CHRNGE

CANCEL SET
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MANUFACTURER DATA

Manufacturer Data is accessed by pressing
the MFG DATA button on the Select Menu
display.

The initial display shows the name and
telephone number of the manufacturer.

Press MODEL INFO to show important
information about your flow meter
including the model number, serial
number, and date of manufacture.

OMEGA

Ph B88G6-826-6342
Fax 283-3539-7706

BACK
Press BACK to return to the MFG DATA
display.

Push MAIN to return to the Main display.

MODEL: FMA-2686A-165LPM-D
SERIAL WO: SEEE3

DATE MFG: 18726812

DATE CAL: 18-9-2612

CAL BY: DL

SWREV: 262

BACK
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FMA-2600A-P Controller Operating Notes
The FMA-2600A-P mass flow controller is equipped with an integrated
Swagelok® positive shutoff valve.
The normally closed valve is air actuated and will remain closed until it is
connected to an air source supplying between 60 and 120 psig of air pressure.
Once the appropriate amount of air pressure is supplied to the shutoff valve,
it will open, allowing flow through the mass controller. Air pressure must be
removed from the shutoff valve in order for the valve to close.
A common method for actuating the shutoff valve incorporates a three-way
solenoid valve (below).
Air pressure is applied to one side of the solenoid valve while the other side of
the solenoid is left open to atmosphere.
When the solenoid is energized, air pressure is delivered to the shutoff valve,
allowing it to open.
When the solenoid is returned to a relaxed state, air pressure is removed from
the shutoff valve, allowing it to close. The air pressure is vented to atmosphere.
Note: All standard FMA-2600A device features and functions are available on the
FMA-2600A-P controllersand operate in accordance with the standard FMA-2600A
operating instructions.

Three-way Solenoid Valve

/Air Supply

s
( " Vent
FMA-2600A-P Controller
\\
\\
\\
I e
{11
il 1 bfm

FMA-2600A-P controller and three-way solenoid valve.
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RS232 / RS485 Output and Input

Configuring HyperTerminal®:

1. Open your HyperTerminal® R$232 / RS485 terminal program (installed under
the “Accessories” menu on all Microsoft Windows® operating systems).

2. Select “Properties” from the file menu.

3. Click on the “Configure” button under the “Connect To” tab. Be sure the
program is set for: 19,200 baud (or matches the baud rate selected in the
RS232 / RS485 communications menu on the meter) and an 8-N-1-None (8
Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.

4. Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI
or Auto Detect.

5. Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line
Feeds” box is not checked and the “Echo Typed Characters Locally” box and
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings
not mentioned here are normally okay in the default position.

6. Save the settings, close HyperTerminal® and reopen it.

Streaming Mode (RS485 units do not have a streaming mode)

In the default Polling Mode, the screen should be blank except the blinking cursor.

In order to get the data streaming to the screen, hit the “Enter” key several times

to clear any extraneous information. Type “*@=@" followed by “Enter” (or using

the RS232 / RS485 communication select menu, select @ as identifier and exit
the screen). If data still does not appear, check all the connections and COM port
assignments.

Streaming Mode — Advanced

The streaming data rate is controlled by register 91. The recommended default rate
of data provision is once every 50 milliseconds and this is suitable for most purposes.

If a slower or faster streaming data rate is desired, register 91 can be changed to a
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute.
Below approximately 40 milliseconds, data provision will be dependent upon
how many parameters are selected. Fewer data parameters can be streamed
more quickly than more. It is left to the user to balance streaming speed with
number of parameters streamed.

To read register 91, type “*r91” followed by “Enter”.

To modify register 91, type “*w91=X", where X is a positive integer from 1 to
65535, followed by “Enter”.

To return to the recommended factory default streaming speed, type “*w91=50".
Changing From Streaming to Polling Mode:

When the meter is in the Streaming Mode (RS485 units do not have a streaming
mode), the screen is updated approximately 10-60 times per second (depending
on the amount of data on each line) so that the user sees the data essentially in
real time. It is sometimes desirable, and necessary when using more than one
unit on a single RS232 line, to be able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of data
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when it is “polled”. Each unit can be given its own unique identifier or address.
Unless otherwise specified each unit is shipped with a default address of capital A.
Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of
information filling your screen:

1. Type *@=A followed by “Enter” (or using the R5232 / RS485 communication
select menu, select A as identifier and exit the screen) to stop the streaming
mode of information. Note that the flow of information will not stop while
you are typing and you will not be able to read what you have typed. Also,
the unit does not accept a backspace or delete in the line so it must be typed
correctly. If in doubt, simply hit enter and start again. If the unit does not
get exactly what it is expecting, it will ignore it. If the line has been typed
correctly, the data will stop.

2. You may now poll the unit by typing A followed by “Enter”. This does an
instantaneous poll of unit A and returns the values once. You may type A
“Enter” as many times as you like. Alternately you could resume streaming
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the
unit from the streaming mode.

3. To assign the unit a new address, type *@=New Address, e.g. *@=B. Care
should be taken not to assign an address to a unit if more than one unit is
on the RS232 / RS485 line as all of the addresses will be reassigned. Instead,
each should be individually attached to the RS232 / RS485 line, given an
address, and taken off. After each unit has been given a unique address, they
can all be put back on the same line and polled individually.

Sending a Set-point via R$232 / RS485: To send a set-point via RS232 / RS485,
“Serial” must be selected under the “Input” list in the control set up mode.
Method 1: Set-point may be set in floating point in serial communication using
serial command (UnitID)SX.YZ

Example: AS4.54 results in Unit ID A changing set-point to 4.54.
Method 2: Type in a number between 0 and 65535 (2% over range), where 64000
denotes full-scale flow rate, and hit “Enter”.

The set-point column and flow rates should change accordingly. If they do not,
try hitting “Enter” a couple of times and repeating your command. The formula
for performing a linear interpolation is as follows:

Value = (Desired Set-point X 64000) / Full Scale Flow Range
For example, if your device is a 100 slpm full-scale unit and you wish to apply a
set-point of 35 slpm you would enter the following value:

22400 = (35 slpm X 64000) / 100 slpm
If the controller is in polling mode as described in Changing from Streaming
Mode to Polling Mode, the set-point must be preceded by the address of the
controller. For example, if your controller has been given an address of D, the
set-point above would be sent by typing:

D22400 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via R$232 / RS485:
Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21 followed
by “Enter”.

The computer will respond by reading the current value for register 21 between
0-65535. It is good practice to write this value down so you can return to the
factory settings if necessary. Enter the value you wish to try by writing the new
value to register 21. For example, if you wished to try a “P” term of 220, you
would type *W21=220 followed by “Enter” where the bold number denotes the
new value.

The computer will respond to the new value by confirming that 21=220. To
see the effect of the change you may now poll the unit by typing A followed
by “Enter”. This does an instantaneous poll and returns the values once. You
may type A “Enter” as many times as you like. Alternately you could resume
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed
by “Enter”.

The computer will respond by reading the current value for register 22 between
0-65535. It is good practice to write this value down so you can return to the
factory settings if necessary. Enter the value you wish to try by writing the new
value to register 22. For example, if you wished to try a “D” term of 25, you
would type *W22=25 followed by “Enter” where the bold number denotes the
new value.

The computer will respond to the new value by confirming that 22=25. To see the
effect of the change you may now poll the unit by typing A followed by “Enter”.
This does an instantaneous poll and returns the values once. You may type A
“Enter” as many times as you like. Alternately you could resume streaming mode
by typing *@=@ followed by “Enter”. Repeat.

You may test your settings for a step change by changing the set-point. To do this
type A32000 (A is the default single unit address, if you have multiple addressed
units on your RS232 / RS485 line the letter preceding the value would change
accordingly.) followed by “Enter” to give the unit a % full scale set-point. Monitor
the unit’s response to the step change to ensure it is satisfactory for your needs.
Recall that the “P” term controls how quickly the unit goes from one set-point to
the next, and the “D” term controls how quickly the signal begins to “decelerate”
as it approaches the new set-point (controls the overshoot).
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Gas Select — The selected gas can be changed via RS232 / RS485 input. To change
the selected gas, enter the following commands:

In Polling Mode: AddressSS#<Enter> (e.g. BSSH<Enter>)

Where # is the number of the gas selected from the table below. Note that this
also corresponds to the gas select menu on the flow controller screen:

# GAS

0 Air Air

1 Argon Ar

2 Methane CH4

3 Carbon Monoxide co

4 Carbon Dioxide Cco2

5 Ethane C2H6

6 Hydrogen H2

7 Helium He

8 Nitrogen N2

9 Nitrous Oxide N20

10 Neon Ne

11 Oxygen 02

12 Propane C3H8

13 normal-Butane n-C4H10

14 Acetylene C2H2

15 Ethylene C2H4

16 iso-Butane i-C2H10

17 Krypton Kr

18 Xenon Xe

19 Sulfur Hexafluoride SF6

20 75% Argon / 25% CO2 C-25

21 90% Argon / 10% CO2 C-10

22 92% Argon / 8% CO2 C-8

23 98% Argon / 2% CO2 Cc-2

24 75% CO2 / 25% Argon C-75

25 75% Argon / 25% Helium A-75

26 75% Helium / 25% Argon A-25
90% Helium / 7.5% Argon / 2.5% CO2

27 (Praxair - Helistar® A1025) A1025

90% Argon / 8% CO2 / 2% Oxygen
e (Praxair - Stargon® CS) Sl
29 95% Argon / 5% Methane P-5

For example, to select Propane, enter: $$12<Enter>
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Creating and Deleting Gas Mixtures with Composer using R$232 or R$485

Note: All commands must be prefixed with the unit ID letter. The unit should
not be in streaming mode.

You may create and store up to 20 gas mixtures containing up to five
constituent gases each. The constituent gases must be chosen from the existing
list of gases installed on the device (which may vary model to model). Please
see pages 39 — 46 for lists of gases and their corresponding gas numbers.
Create a Gas Mixture
To create a gas mixture, enter a single-line command according to the following formula:
[Unit ID] GM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1]
[Percent 2] [Gas Number 2] ...etc. etc.
Notes: Do not type the brackets. There should be only one space between
all items. Any percentages less than 1, should have a leading zero before
the decimal (i.e. 0.25 for .25%). Trailing zeros are not necessary but they are
allowed to help visualize the percentages on screen (as in the example). The
sum of all percentages must be 100.00 otherwise an error will occur.
Here is an example of a three gas mixture for a new gas called “MyMix1”
(50% 02, 49.5% Helium, and .5% Neon), stored in user location #236, where the
unit ID of the device is “A”:
A GM MyMix1 236 50.00 11 49.50 7 0.50 10 <ENTER>
Gas Name: Name your mixture using a maximum of 6 characters.
Gas Mix Number: Composer user mixes have Omega gas numbers between
236 and 255. You can assign any number in this range to your new mixture. If
another mixture with the same number exists, it will be overwritten, even if
that gas is currently selected on the unit. If you enter a 0 here, the new mix
will be assigned the next available number between 236 and 255.
Percent 1: The percentage of the first constituent gas. The percentage of each
constituent must be between 0.01 and 99.99. Values entered beyond two
decimal points will be rounded to the nearest 0.01%.
Gas Number 1: The Omega gas number of the first constituent gas.
Percent 2: The percentage of the second constituent gas. Values entered
beyond two decimal points will be rounded to the nearest 0.01%.
Gas Number 2: The Omega gas number of the second constituent gas.
Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number]
may be repeated for additional constituent gases (up to a total of five).
Upon success, the unit ID (if set) is returned followed by a space. The number
of the gas mixture is then returned, followed by the percentages and names
of each constituent in the mix. If the gas mix is not successfully created, a "?"
is returned, and you must start over.
Delete a Gas Mixture
To delete a gas mixture, enter:
[Unit ID]GD [Gas Number]: The number of the Composer user mixture you
wish to delete from the unit
Only Composer user mixtures can be deleted with this command.

On success, the unit ID (if set) is returned followed by a space and the number of
the gas deleted. If the gas is not successfully deleted, a "?" is returned.

35



Collecting Data:

The RS232/RS485 output updates to the screen many times per second. Very short-
term events can be captured simply by disconnecting (there are two telephone
symbol icons at the top of the HyperTerminal® screen for disconnecting and
connecting) immediately after the event in question. The scroll bar can be driven up
to the event and all of the data associated with the event can be selected, copied,
and pasted into Microsoft® Excel® or other spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text file. With the desired
data streaming to the screen, select “Capture Text” from the Transfer Menu. Type
in the path and file name you wish to use. Push the start button. When the data
collection period is complete, simply select “Capture Text” from the Transfer Menu
and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from a text
file can be pasted directly into Excel®. When the data is pasted it will all be in the
selected column. Select “Text to Columns..” under the Data menu in Excel® and a
Text to Columns Wizard (dialog box) will appear.

Make sure that “Fixed Width” is selected under Original Data Type in the first dialog
box and click “Next”. In the second dialog box, set the column widths as desired,
but the default is usually acceptable. Click on “Next” again. In the third dialog
box, make sure the column data format is set to “General”, and click “Finish”. This
separates the data into columns for manipulation and removes symbols such as
the plus signs from the numbers. Once the data is in this format, it can be graphed
or manipulated as desired. For extended term data capture see page 37.

Data Format:

The data stream on the screen represents the flow parameters of the main mode
in the units shown on the display.

For mass flow controllers, there are six columns of data representing pressure,
temperature, volumetric flow, mass flow, set-point, and the selected gas

The first column is absolute pressure (normally in psia), the second column is
temperature (normally in °C), the third column is volumetric flow rate (in the
units specified at time of order and shown on the display), the fourth column is
mass flow (also in the units specified at time of order and shown on the display),
the fifth column is the currently selected set-point value, the sixth column
designates the currently selected gas. For instance, if the controller was ordered
in units of scfm, the display on the controller would read 2.004 scfm and the last
two columns of the output below would represent volumetric flow and mass
flow in cfm and scfm respectively.

+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
Pressure Temp Vol. Flow  Mass Flow  Set Point Gas

FMA-2600A Mass Flow Controller Data Format

Note: On units with the totalizer function, the sixth column will be the totalizer
value, with gas select moving to a seventh column.
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Sending a Simple Script File to HyperTerminal®

Itis sometimes desirable to capture data for an extended period of time. Standard
streaming mode information is useful for short term events, however, when
capturing data for an extended period of time, the amount of data and thus the
file size can become too large very quickly. Without any special programming
skills, the user can use HyperTerminal® and a text editing program such as
Microsoft® Word® to capture text at user defined intervals.

1. Open your text editing program, MS Word for example.

2. Set the cap lock on so that you are typing in capital letters.

3. Beginning at the top of the page, type A<Enter> repeatedly. If you're using MS
Word, you can tell how many lines you have by the line count at the bottom of the
screen. The number of lines will correspond to the total number of times the flow

device will be polled, and thus the total number of lines of data it will produce.
For example: A

> > > >

A
will get a total of six lines of data from the flow meter, but you can
enter as many as you like.

The time between each line will be set in HyperTerminal.

4. When you have as many lines as you wish, go to the File menu and select save.
In the save dialog box, enter a path and file name as desired and in the “Save as
Type” box, select the plain text (.txt) option. It is important that it be saved as a
generic text file for HyperTerminal to work with it.

5. Click Save.

6. A file conversion box will appear. In the “End Lines With” drop down box, select
CR Only. Everything else can be left as default.

7. Click O.K.

8. You have now created a “script” file to send to HyperTerminal. Close the file
and exit the text editing program.

9. Open HyperTerminal and establish communication with your flow device as
outlined in the manual.

10. Set the flow device to Polling Mode as described in the manual. Each time you
type A<Enter>, the meter should return one line of data to the screen.

11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.

14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell
the program how often to read a line from the script file you’ve created. 1000
milliseconds is one second, so if you want a line of data every 30 seconds, you
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would enter 30000 into the box. If you want a line every 5 minutes, you would
enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the
Properties dialog box.

16. Go the Transfer menu and select “Send Text File...” (NOT Send File...).
17. Browse and select the text “script” file you created.
18. Click Open.

19. The program will begin “executing” your script file, reading one line at a time
with the line delay you specified and the flow device will respond by sending one
line of data for each poll it receives, when it receives it.

You can also capture the data to another file as described in the manual under
“Collecting Data”. You will be simultaneously sending it a script file and capturing
the output to a separate file for analysis.

Operating Principle

All FMA-1600A Gas Flow Meters and FMA-2600A Gas Flow Controllers are based on
the accurate measurement of volumetric flow. The volumetric flow rate is determined
by creating a pressure drop across a unique internal restriction, known as a Laminar
Flow Element (LFE), and measuring differential pressure across it. The restriction is
designed so that the gas molecules are forced to move in parallel paths along the
entire length of the passage; hence laminar (streamline) flow is established for the
entire range of operation of the device. Unlike other flow measuring devices, in
laminar flow meters the relationship between pressure drop and flow is linear.

STANDARD GAS DATA TABLES: Those of you who have older FMA-2600A
products may notice small discrepancies between the gas property tables of
your old and new units. Omega has incorporated the latest data sets from NIST
(including their REFPROP 9 data where available) in our products’ built-in gas
property models. Be aware that the calibrators that you may be using may be
checking against older data sets such as the widely distributed Air Liquide data.
This may generate apparent calibration discrepancies of up to 0.6% of reading on
well behaved gases and as much as 3% of reading on some gases such as propane
and butane, unless the standard was directly calibrated on the gas in question.

As the older standards are phased out, this difference in readings will cease to
be a problem. If you see a difference between the Omega meter and your in-
house standard, in addition to calling Omega at, call the manufacturer of your
standard for clarification as to which data set they used in their calibration. This
comparison will in all likelihood resolve the problem.
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Supported Units: This device supports many different units. You may select the desired units (see
page 28). Note that only units appropriate to this device are available for selection.
Pressure Units

Absolute Gauge Differential Notes
PaA PaG PaD pascal
hPaA hPaG hPaD hectopascal
kPaA kPaG kPaD kilopascal
MPaA MPaG MPaD megapascal
mbarA mbarG mbarD millibar
barA barG barD bar
g/cm2A g/cm2G g/cm2D gram force per square centimeter
kg/cmA kg/cmG kg/cmD kilogram force per square centimeter
PSIA PSIG PSID pound force per square inch
PSFA PSFG PSFD pound force per square foot
mTorrA mTorrG mTorrD millitorr
torrA torrG torrD torr
mmHgA mmHgG mmHgD millimeter of mercury at 0 C
inHgA inHgG inHgD inch of mercury at 0 C
mmH20A mmH20G mmH20D millimeter of water at 4 C (NIST conventional)
mmH20A mmH20G mmH20D millimeter of water at 60 C
cmH20A cmH20G cmH20D centimeter of water at 4 C (NIST conventional)
cmH20A cmH20G cmH20D centimeter of water at 60 C
inH20A inH20G inH20D inch of water at 4 C (NIST conventional)
inH20A inH20G inH20D inch of water at 60 C
atm atmosphere
m asl meter above sea level (only in /ALT builds)
ftasl foot above sea level (only in /ALT builds)
V volt; no conversions are performed to or from other units
count count count setpoint count, 0 - 64000
% % % percent of full scale

Flow Units

Volumetric Standard Normal Notes
uL/m SuL/m NuL/m microliter per minute
mL/s SmL/s NmL/s milliliter per second
mL/m SmL/m NmL/m milliliter per minute
mL/h Smi/h NmL/h milliliter per hour
L/s SL/s NL/s liter per second
LPM SLPM NLPM liter per minute
L/h SL/h NL/h liter per hour
US GPM US gallon per minute
US GPH US gallon per hour
CCS SCCS NCCS cubic centimeter per second
CCM SCCM NCCM cubic centimeter per minute
cm3/h Scm3/h Ncm3/h cubic centimeter per hour
m3/m Sm3/m Nm3/m cubic meter per minute
m3/h Sm3/h Nm3/h cubic meter per hour
m3/d Sm3/d Nm3/d cubic meter per day
in3/m Sin3/m cubic inch per minute
CFM SCFM cubic foot per minute
CFH SCFH cubic foot per hour
kSCFM 1000 cubic feet per minute
count count count setpoint count, 0 — 64000
% % % percent of full scale
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True Mass Flow Units

Label Notes
mg/s milligram per second
mg/m milligram per minute
g/s gram per second
g/m gram per minute
g/h gram per hour
kg/m kilogram per minute
kg/h kilogram per hour
0z/s ounce per second
oz/m ounce per minute
Ib/m pound per minute
Ib/h pound per hour

These can be used for mass flow on gas devices. These can also be used for volumetric flow on liquid
devices calibrated in one of these units (liquid density is not yet supported).

Totalizer Units

Volumetric Standard Normal Notes
ulL SuL NulL microliter
mL SmL NmL milliliter
L SL NL liter
US GAL US gallon
cm3 Scm3 Ncm3 cubic centimeter
m3 Sm3 Nm3 cubic meter
in3 Sin3 cubic inch
ft3 Sft3 cubic foot
kSft3 1000 cubic feet
uP micropoise, a measure of viscosity; no conversions are performed to or from
other units
Total Mass Units
Label Notes
mg milligram
g gram
kg kilogram
0z ounce
b pound
These can be used for totalized mass on gas devices. These can also be used for totalized
volume on liquid devices calibrated in one of these units (liquid density is not yet supported).
Temperature Units
Label Notes
°C degree Celsius
°F degree Farenheit
K Kelvin
°R degree Rankine

Time Units

Label Notes
h:m:s Displayed value is hours:minutes:seconds
ms millisecond
s second
m minute
hour hour
day day

Valve Drive Units

Label Notes
count +/- 65536 at full drive
% Percent of full scale drive
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TROUBLESHOOTING

Display does not come on or is weak.
Check power and ground connections. Please reference the technical specifications
(pages 56 - 71) to assure you have the proper power for your model.

Flow reading is approximately fixed either near zero or near full scale
regardless of actual line flow.

Differential pressure sensor may be damaged. A common cause of this problem
is instantaneous application of high-pressure gas as from a snap acting solenoid
valve upstream of the meter. If you suspect that your pressure sensor is
damaged please discontinue use of the controller and contact Omega.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and
message MOV, VOV, POV or TOV is displayed:

Our flow meters and controllers display an error message (MOV = mass
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV =
temperature overrange) when a measured parameter exceeds the range of the
sensors in the device. When any item flashes on the display, neither the flashing
parameter nor the mass flow measurement is accurate. Reducing the value of
the flashing parameter to within specified limits will return the unit to normal
operation and accuracy. If the unit does not return to normal contact Omega.

After installation, there is no flow.

FMA-2600A controllers incorporate normally closed valves and require a set-point
to operate. Check that your set-point signal is present and supplied to the correct
pin and that the correct set-point source is selected under the SETPT SOURCE list
in the control set up display. Also check that the unit is properly grounded.

The flow lags below the set-point.

Be sure there is enough pressure available to make the desired flow rate. If
either the set-point signal line and/or the output signal line is relatively long, it
may be necessary to provide heavier wires (especially ground wiring) to negate
voltage drops due to line wire length. An inappropriate PID tuning can also
cause this symptom if the D term is too large relative to the P term. See pages
18 and 19 for more information on PID tuning.

Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions
considerably different than those at which the device was originally set up

can necessitate a re-tuning of the PID loop. See pages 20 and 21 for more
information on PID tuning.

The output signal is lower than the reading at the display.

This can occur if the output signal is measured some distance from the meter,
as voltage drops in the wires increase with distance. Using heavier gauge wires,
especially in the ground wire, can reduce this effect.
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Meter does not agree with another meter | have in line.

Volumetric meters are affected by pressure drops. Volumetric flow meters
should not be compared to mass flow meters. Mass flow meters can be
compared against one another provided there are no leaks between the two
meters and they are set to the same standard temperature and pressure. Both
meters must also be calibrated (or set) for the gas being measured. FMA-1600A
mass flow meters are normally set to Standard Temperature and Pressure
conditions of 25° C and 14.696 psia. Note: it is possible to special order meters
with a customer specified set of standard conditions. The calibration sheet
provided with each meter lists its standard conditions.

When performing this comparison it is best to use the smallest transition
possible between the two devices. Using small transitions will minimize lag and
dead volume.

RS232 / RS485 Serial Communications is not responding.

Check that your meter is powered and connected properly. Be sure that the
port on the computer to which the meter is connected is active. Confirm that
the port settings are correct per the RS232 instructions in this manual (Check
the RS232 / RS485 communications select screen for current meter readings).
Close Hyperterminal® and reopen it. Reboot your PC. See pages 10, 11 and 30
for more information on RS$232 / RS$485 signals and communications.

Slower response than specified.

FMA-2600A Controllers feature a programmable Geometric Running Average
(GRA). Depending on the full scale range of the meter, it may have the GRA
set to enhance the stability/readability of the display, which would result in
slower perceived response time. Please see “Pressure Averaging” and “Flow
Averaging” on page 26.

Jumps to zero at low flow.

FMA-2600A Controllers feature a programmable zero deadband. The factory
setting is usually 0.5% of full scale. This can be adjusted between NONE and
6.3% of full scale. See page 26.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 38.
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Maintenance and Recalibration

General: FMA-2600A Flow Controllers require minimal maintenance. They
have no moving parts. The single most important thing that affects the life
and accuracy of these devices is the quality of the gas being measured. The
controller is designed to measure CLEAN, DRY, NON-CORROSIVE gases.

Moisture, oil and other contaminants can affect the laminar flow elements.
We recommend the use of in-line sintered filters to prevent large particulates
from entering the measurement head of the instrument. Suggested maximum
particulate sizes are as follows:

5 microns for units with FS flow ranges of 0-1 sccm or less.

20 microns for units with FS flow ranges between 0-2 sccm and 0-1 slpm.

50 microns for units with FS flow ranges of 0-1 slpm or more.

Recalibration: The recommended period for recalibration is once every year. A
label located on the back of the controller lists the most recent calibration date.
The controller should be returned to the factory for recalibration within one
year from the listed date. Before calling to schedule a recalibration, please note
the serial number on the back of the instrument. The Serial Number, Model
Number, and Date of Manufacture are also available on the Model Info display
(page 29).

Cleaning: FMA-2600A Flow Controllers require no periodic cleaning. If
necessary, the outside of the controller can be cleaned with a soft dry cloth.
Avoid excess moisture or solvents.

For repair, recalibration or recycling of this product contact Omega.

51



Option: Totalizing Mode - Controllers

Controllers can be purchased with the Totalizing Mode option. This option adds
an additional mode screen that displays the total flow (normally in the units of
the main flow screen) that has passed through the device since the last time the
totalizer was cleared. The Totalizing Mode screen is accessed by pushing the
TOTAL/TIMER button on the MAIN display.

TOTAL/TIMER: Pushing the TOTAL/TIMER button
will cycle the large numbers on the display

between total mass and time elapsed.

TOTAL-  SETPT .
TIMER  +123.4 . Rollover — The customer can also specify at the

time of order what the totalizer is to do when

the maximum count is reached. The following
+123-45 options may be specified:

S56:56 himis

No Rollover — When the counter reaches the

MENU.- - : . .
EATCH  RESET AT maximum count it stops counting until the
counter is cleared.

Rollover — When the counter reaches the
maximum count it automatically rolls over to
zero and continues counting until the counter is cleared.

Rollover with Notification — When the counter reaches the maximum count
it automatically rolls over to zero, displays an overflow error, and continues
counting until the counter is cleared.

TOTAL MASS: The counter can have as many as seven digits. At the time of order,
the customer must specify the range. This directly affects the maximum count. For
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in
liters, the maximum count would be 99999.99 liters. If the same unit were specified
with a 1 liter range, the maximum count would be 9999999 liters.

ELAPSED TIME: The small numbers below the mass total show the elapsed time
since the last reset in hours, minutes and seconds. The maximum measurable
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when
RESET is pushed, an RS232 or RS485 clear is executed or on loss of power. Press
TOTAL/TIMER to show this as the primary display.

SETPT: Pushing SETPT will allow you to change the controller's set-point.

RESET — The counter can be reset to zero at any time by pushing the RESET
button. To clear the counter via RS232 or RS485, establish serial communication
with the meter or controller as described in the RS232 or RS485 section of the
manual. To reset the counter, enter the following commands:

In Polling (addressable) Mode: AddressSST <Enter> (e.g. BSST <Enter>)

THE MASS FLOW RATE MAY MOMENTARILY EXCEED THE FLOW MEASUREMENT
CAPABILITY (FULL SCALE + 28%) OF THE UNIT. THIS MAY OCCUR WHEN THE UNIT IS
ASKED TO MAKE AN ABRUPT PRESSURE CHANGE.
IF THE TOTALIZER IS IN USE AT THAT TIME, THE TOTALIZED VALUE WILL NECESSARILY BECOME
INCORRECT. PLEASE RESET THE TOTALIZER IF SUCH AN ‘OVER-FLOW’ CONDITION HAS OCCURRED.

f WHEN USING A MASS FLOW CONTROLLER AS AN ABSOLUTE PRESSURE CONTROLLER,
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BATCH PROCESSING MODE — CONTROLLERS ONLY

Batch mode is a function within the optional Totalizing mode. Batch mode is
designed to provide repeatable, finite flow quantities.

To activate Batch Mode: Press BATCH. Then use
SELECT DIGIT to move the arrow to the desired digit,
and the UP and DOWN buttons to change the value.
Bateh Size Send Press CLEAR to return to zero. Press SET to record
ElEl].ES 45 your value. If the controller has a non-zero Set-Point,
flow will start immediately. If not, press SETPT to

select a Set-Point.

SR Ciear Batch values can also be established via RS232/RS485

communication using Register 92. (See RS232/RS485
Section of this manual for serial communication methods.)

Note: While the Totalizer counter will still reset across
power cycles, the Batch process value is stored in EEPROM and will remain valid
until updated by the user.

While the Batch is processing, the remaining amount of the Batch value is
displayed above REMAIN on the Totalizer screen. Time elapsed during the Batch
processing is displayed below the totalizing counter. Press TOTAL/TIMER to
toggle these values.

When the active Totalizer reaches the preset Batch value, flow ceases, and
REMAIN updates to Done Batch. The Totalizer timer also pauses.

- To start a new batch of the same size, simply press
RESET. The Totalizer can reproduce any number of

S — m fixed Batches in this manner.
TIMER  123.4 +Ef55-4
cons - To start a smaller batch, decrease the Batch value.

ElE'].ES 45 The new batch begins when you press RESET.
%14 e - To continue the existing batch to a larger total

volume, increase the Batch value. Flow resumes as
soon as you press OK in the Batch Value screen.

RENHIN RESET MENLI

- To start a larger batch from scratch, first clear the
flow Set-Point to zero to prevent unwanted flow.
Then increase the Batch value, and select a flow Set-Point. Flow will begin when
you press SET in the Set-Point screen.

- To cancel a batch in progress, clear the Set-Point and press SET.

Note: Batch mode operates independently of the desired flow rate, but requires
a non-zero flow rate to run. The rate of flow is determined by the controller
Set-Point value, which is established by the user via analog, front panel or serial
communication methods. Batches can be produced more slowly or more rapidly
as determined by the user-selected Set-Point flow rate.

To turn off Batch Mode: Set the Batch value to zero (0.0) via the front panel or
RS232/RS485 communication using Register 92. If there is a non-zero flow Set-
Point, flow will immediately resume, and the Totalizer counter will continue per
the user established Set-Point flow rate.
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Accessory: FMA1600-MDB Multi-Drop Box

The FMA1600-MDB Multi-Drop Box makes it convenient

e e @ . i . .
| T to wire multiple flow and/or pressure devices to a single
M RS232 or RS485 port.
| a9 @
{ s Now available with a USB interface!
I'\,ﬁ_ il The Multi-Drop Box has nine 8 pin mini-DIN ports
il

available. The ports are to be used with a standard
double ended 8 pin mini-DIN style cable going from the
box to each flow or pressure device.

A single DB9 D-SUB type connector (COM PORT) connects, using the included
cable, to the serial connector on a PC or laptop.

All of the flow and/or pressure devices are powered via a terminal block on the
front of the box.

If more than nine devices will be required, additional Multi-Drop Boxes can be
daisy chained together with a double ended 8 pin mini-DIN cable plugged into
any receptacle on both boxes.

Multi-Drop Box Power Supply for Large Valve Controllers: The PS24VHC
(Power Supply 24Vdc High Current) is a 6.5Amp 24Vdc power supply designed
for running multiple large controllers on a Multi-Drop Box.

The 6.5Amp power supply can run as many as 8 large valve controllers, which
makes it ideal for the Multi-Drop Box and multiple large valve (or small valve /
large valve combination) controllers on a Multi-Drop Box.

FMA1600-MDB Multi-Drop Box
@ 156 Thru 4 Places | 6.75 1 155 —
-.x:._ﬁ;—_—'—_ — :‘___"ﬁ_"\
i ;
' -
1.75 OO C
346 | - H O O O |k 505
ot il s ."'
0o O O \
r';. ! =] h
340 Thu2 PL || e —Jlq N
d 6.75 \
7.56 “@ 175 Thru 2 PL
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Accessories

Part Number Description

FMA1600-C1 8 Pin Male Mini-DIN connector cable, single ended,
6 foot length

FMA1600-C2 8 Pin Male Mini-DIN connector cable, double ended,
6 foot length

EMA1600-C3 IE;::’ér;hMale Mini-DIN to DB9 Female Adapter, 6 foot

FMA1600-PSU Universal 100-240 VAC to 24 Volt DC Power Supply
Adapter

FMA1600-CRA

8 Pin Male Right Angle Mini-Din Cable, single ended,
6 foot length

FMA1600-C1-25FT

8 Pin Male Mini-DIN connector cable, single ended,
25 foot length

FMA1600-C2-25FT

8 Pin Male Mini-DIN connector cable, double ended,
25 foot length

FMA1600-MDB

Multi-Drop Box
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Technical Data for FMA-2600A Mass Flow Controllers
0 to 0.5 sccm Full Scale through 0 to 3000 slpm Full Scale

Standard Operating Specifications (Contact Omega for available options)

Performance

Accuracy at calibration
conditions after tare

FMA-2600A Mass Flow Controller
+ (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration
conditions after tare

+ (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Repeatability

+ 0.2% Full Scale

Zero Shift and Span Shift

0.02% Full Scale / °Celsius / Atm

Operating Range / Tumdown Ratio

0.5% to 100% Full Scale / 200:1 Turndown

Maximum Controllable Flow Rate

102.4% Full Scale

Typical Response Time

100 ms (Adjustable)

Warm-up Time

<1 Second

Mass Reference Conditions (STP)

Operating Conditions FMA-2600A Mass Flow Controller

25°C & 14.696 psia (standard — others available on request)

Operating Temperature

-10 to +50 °Celsius

Humidity Range
(Non—Condensing)

0to 100%

Maximum Pressure

145 psig

Mounting Attitude Sensitivity

Small Valve: None Large Valve: Mount with valve cylinder vertical & upright

Valve Type

Normally Closed

Ingress Protection

P40

Wetted Materials

Small Valve: 303 & 302 Stainless Steel, FKM, Heat Cured Silicone Rubber, Glass
Reinforced Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Brass, 430FR
Stainless Steel, Silicon, Glass.

Large Valve: 303 & 302 Stainless Steel, FKM, Heat Cured Silicone Rubber,

Glass Reinforced Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, 416
Stainless Steel, Silicon, Glass. If your application demands a different material,
please contact Omega.

Monochrome LCD Display with
integrated touchpad

Communications / Power FMA-2600A Mass Flow Controller

Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal' Options

RS232 Serial / RS485 Serial

Analog Input/Output Signal? Options

0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA

Optional Secondary Analog

0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA

Input/Output Signal?
Electrical Connection Options 8 Pin Mini-DIN / 15-pin D-sub (DB15)
Supply Voltage Small Valve: 12 to 30 Vdc (15-30 Vdc for 4-20 mA outputs) Large Valve: 24 to 30 Vdc
Supply Current Small Valve: 0.250 Amp Large Valve: 0.750 Amp

Flow, Volumetric Flow, Pressure

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass

or Temperature

Full Scale Flow Mass
Controller

Pressure Drop' at FS Flow
(psid) venting to atmosphere

Range Specific Specifications

Mechanical

. . Process Connections?
Dimensions

0.5 sccm to 50 sccm 1.0 3.9"Hx3.4'Wx1.1"D | M-5(10-32) Female Thread
100 sccm to 500 sccm 1.0
1 slpm 1.5
ZEIpi] g0 41"HX3.6'Wx 1.1'D 1/8” NPT Female
5 slpm 2.0
10 slpm 5.5
20 slpm 20.0
50 slpm 9.0
100 slpm 11.7 4.4’H x 6.4"W x 2.3'D 1/4” NPT Female
250 slpm 24
500 slpm 6.5 3/4” NPT Female
1000 slpm 14.0 55"Hx7.4"Wx 23D |(A1-1/4" NPT Female process
1500 slpm 17.0 connection is available for
2000 slpm 28.6 5.5"Hx8.1” W x2.9"D 2000 slpm controllers.)
3000 slpm 16.8 5.5"Hx8.9°Wx2.9"D 1-1/4” NPT Female

connections upon request.

1. Lower Pressure Drops Available, please contact Omega.
2. Compatible with Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE
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EMA-2600A |

Upstream Valve [26.6700m] [ ©
0-0.5sccm 1.050in ®
0-1sccm T
0-2sccm
0-5sccm
0-10 sccm
0-20 sccm E?,@“"
0-50 sccm +0.000%
vl W wan] |l [98.98mm)]
oo 3.897in
[8.53mm] [8.53mm)]
.336in ‘ ° o ‘F .336in
[13.34mm] [84.77mm] __| [13.34mm]
.525in 3.338in " T505in
M5X0.8 (10-32 UNF) :
BOTH SIDES [s6.50mm] _
2.225in L [3.81mm] [3.18mm]
150 o5
L N
L [23.50mm]
.925in
8-32UNC ¥ .175in[4.45mm]
0.5 sccm to 50 sccm approximate shipping weight: 1.1 Ib.
EMA-2600A |
Downstream Valve* ©
0-0.5sccm [26‘67”)”“]
0-1'scem 1.050in
0-2sccm f
0-5sccm
0-10 sccm
0-20 sccm [FJ)
0 - 50 sccm s
+0.000°%"
RIS, B [98.98mm]
oo 3.897in
[8.53mm} _‘ [4 03 ]
.336in .93mm
¥ = ‘ ool [ 194in
[84.77mm] !
[13.34mm] | | \ M5X0.8 (10-32 UNF) 3.338in || [13.34mm]
.525in Both Sides .525in
_. [56.52mm]
[381mm]_ |, 2225n [3.18mm]
| .150in .125in
[23.50mm] 6 ® oo T
.925in E

| @ 0 © )
8-32UNC V¥ .175in[4.45mm]

* Note process connection port locations for downstream valve in this flow range.

0.5 sccm to 50 sccm approximate shipping weight: 1.1 Ib.
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FMA-2600A

0 - 100 sccm L
0 - 200 sccm [26.67mm] ©
0 - 500 sccm 1.050in ©
0-1slpm f
0-2slpm
0-3slpm
0-5slpm
0-10 slpm
0 - 20 slpm
[103.30mm)]
4.067in
[8.89mm] - [8.89mm]
Seom ‘ LA tF .350in
94.95mm]
[13.34mm]_| 1/8 NPT — My L [13.34mm]
525in Both Sides 3.738in 525in
[56.52mm]
22290 [3.81mm] [3-‘8”.‘”“}
T ason | 125N
1
[23.50mm)]
.925in
2X ¢ 8-32UNC T .350in[8.89mm]
100 sccm to 20 slpm approximate weight: 1.2Ib
EMA-2600A
0 - 50 slpm
0-100 slpm
f
[57.15mm]
2.250in
L
[110.92mm]
4.367in
[12.70r_nm] [12.70mm]
.500in .500in
[28.58mm] 1/4 NPT L [16256mm]____ |
1.125in Both Sides 6.400in [Q?Afgg_wm]
. in
[54.61mm]
2.150in . [82.55mm]
[6-35”?””] —~ 3'250"1__7 [19.05mm] [12.70mm]
[47.63mm] 2301 780 1" s00in
18750 1 : ’
[9.53mm)] J T
.375in
/ ° ~ L [44.45mm]
1.750in
4X 8-32 UNC ¥ .500in[12.700mm]

4X 8-32 UNC T .375in[9.525mm]

50 slpm to 100 slpm approximate weight: 7.0 Ib.
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EMA-2600A
0 - 250 slpm ! —
[57.15mm] [40.64mm]
2.250in 1.600in
1
of
[139.56mm]
5.495in
5 5
[28.45mm] e [ [28.45mm]
1.120in 4@ 1.120in
—]Lo o L |
= T [8.13mm]
1/2" NPT -13m
[28.58mm] | Both Sides [19431mm] 320in [20.32mm]
1.125in ’ .800in
[78.11mm] [
M 82.55mm|
3.075in — =
[953 ] [14.6lmm]7“ 3.250in []905 ]
->smm -575in — L19.05mm [4.45mm]
375in ] [‘— -750in y 175
i 71
o o [36.20mm]
[4]7.3:;2_1m] ] P 1.425in
£75n 4X ® 8-32 UNC T .375in[9.53mm)]
" [33.66mm]
4X 8-32 UNC T .328in[8.33mm] T 320m " REF

250 slpm approximate weight: 9.0 Ib.

EMA-2600A
0 - 500 slpm
0 - 1000 slpm
0 - 1500 slpm
[57.1 5mm] [40.64mm]
2.250in rr 1.600in
lr 'J, 4—‘
184 79mm
7.2750in
[T
s
J %’3’5 [133.88mm)]
[139.56mm] 5.2710in
5.495i =
[28.45mm] " {
1.120in ’ ‘l
. 8
3/4 NPT L [8.13mm]
Both Sides .320in
D?‘fgg?r:“] [68.58mm],
. 2.700in __, [82.550mm]
[5.08mm] _| 3.250in
[47.63mm] _ .200in [19.050mm]
1.875in | .750in r
L ) I L
[9.53mm] 1| [4.45mm]
375in 175in
" | . 3

4X 8-32UNC ¥ .328in[8.33mm]

[33.66mm]

1.325in

REF

4X 8-32 UNC

1500 slpm approximate weight: 9.0 Ib.
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EMA-2600A

0 - 2000 slpm
3 ® f
[73.66mm] o [57.15mm]
2.900in ° 2.250in
3 ° |
Q (<}
@
[139.56mm]
[28.45mm] T 4 n B o [28.45mm]
1.120in 1.120in
° o
[36.83mm 3/4 NPT [205.74mm]
1.450in BOTH SIDES 8.100in D?’fg;'nm]
[171.45mm] :
6.750in [107.95mm)]
[5'%8?[:“] leg.58mm] 42500
' —l T 2.700in_,[_ [5.08mm]
W 1 | 1 T .200in |
[68.58mm] 1 [9.53mm] [417@;;‘;”]
2.700in B 375in ’
o
4X8-32 UNC T .330in[8.38mm] 4X8-32 UNC T .328in[8.33mm]
2000 slpm approximate weight: 12.0 Ib.
EMA-2600A ) ©
0 - 3000 slpm 0@ &) ®
[73.66mm] A o o [57.15mm]
2.900in e 2.250in
o ° i
[+} o]
I [139.56mm]
Aloleld — 5.495in
[24.38mm] © 9 o [24.38mm]
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(+] (] °
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w[97.79mm] [88.90mm] _
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b
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3000 slpm approximate weight: 12.0 Ib.
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Technical Data for FMA-LP2600A Low Pressure Drop Mass Flow Controllers
0 to 0.5 sccm Full Scale through 0 to 500 slpm Full Scale
Standard Specifications (Contact Omega for available options.)

Performance FMA-LP2600A Mass Flow Controller

Accuracy at calibration + (0.8% of Reading + 0.2% of Full Scale)
conditions after tare

High Accuracy at calibration + (0.4% of Reading + 0.2% of Full Scale)
conditions after tare High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.
Repeatability + 0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / °Celsius / Atm
Operating Range / Tumdown Ratio 0.5% to 100% Full Scale / 200:1 Turndown
Maximum Controllable Flow Rate 102.4% Full Scale
Typical Response Time 100 ms (Adjustable)
Warm-up Time < 1 Second
Mass Reference Conditions (STP) 25°C & 14.696 psia (standard — others available on request)
Operating Temperature -10 to +50 °Celsius

Humidity Range

(Non—Condensing) 010 100%
Maximum Pressure 50 psig Higher line pressures available, please contact Omega.
Mounting Attitude Sensitivity Small Valve: None Large Valve: Mount with valve cylinder vertical & upright
Valve Type Normally Closed
Ingress Protection P40

Small Valve: 303 & 302 Stainless Steel, FKM, Silicone RTV (Rubber), Glass
Reinforced Nylon, Aluminum, Brass, 430FR Stainless Steel, Silicon, Glass.
Wetted Materials Large Valve: 303 & 302 Stainless Steel, FKM, Silicone RTV (Rubber), Glass
Reinforced Nylon, Aluminum, 416 Stainless Steel, Nickel, Silicon, Glass.

If your application demands a different material, please contact Omega.

Communications / Power FMA-LP2600A Mass Flow Controller
Monochrome LCD Display with

integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal1 Options RS232 Serial / RS485 Serial
Analog Input/Output Signal® Options 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA
Optional Secondary Analog
5 0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA
Input/Output Signal
Electrical Connection Options 8 Pin Mini-DIN /15-pin D-sub (DB15)
Supply Voltage Small Valve: 12 to 30 Vdc (15-30 Vidc for4-20 mAoutputs) |  Large Valve: 24 to 30 Vdc
Supply Current Small Valve: 0.250 Amp Large Valve: 0.750 Amp

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass
Flow, Volumetric Flow, Pressure or Temperature

Range Specific Specifications

Full Scale Flow Mass Pressure Drop at FS Flow Mechanical L q
Controller (psid) venting to atmosphere Dimensions Process Connections
0.5 sccm to 2 sccm 0.06
5 scom to 10 scom 0.08 39Hx34'Wx1.1D | M-5(10:32) Female
Thread
20 sccm 0.07
50 scecm to 200 sccm 0.07
500 scem 0.08 41"Hx 3.6'Wx 1.1'D 1/8" NPT Female
1 slpm 0.10
2 slpm 0.18
5 slpm 0.10
10 slpm 0.12 5.5"H x 7.7"W x 2.3'D 1/4” NPT Female
20 slpm 0.26
40 slpm 0.14 5.5"Hx 7.7"W x 2.3"'D 1/2" NPT Female
50 slpm 0.17
100 slpm 0.30 5.5"H x 7.3"W x 2.3'D 3/4” NPT Female
250 slpm 0.69
500 slpm 0.69 5.5"Hx 8.1"W x 2.7°D 3/4” NPT Female

1. Compatible with, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE
connections upon request.
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EMA-LP2600A
0-0.5sccm
0-1sccm
0-2sccm
0-5sccm
0-10 sccm
0-20 sccm

|

[26.67mm]
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f

[8.53mm]

.336in ]ﬁ@? o
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.525in
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0 - 500 sccm
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[8.89mm]
.350in t

[13.34mm]
.525in
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0 G
\ o 1
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) — .18mm]
22250 | [381mm] [ .125in
ﬂ 150in
ODJ‘@ © @0—{
o lco—e t [23.50mm]
.925in

2X 8-32UNC V¥ .175in[4.45mm]

0.5 sccm to 20 sccm approximate shipping weight: 1.1 Ib.

|

[26.67mm
1.050in

©
G

f

1/8 NPT
Both Sides

[103.30mm]
4.067in
o
| [==
[o1.12mm] _ |
3.588in
[56.52mm]
2.225in
L [3.81mm]
.150in (
(T

2X @ 8-32UNC T .350in[8.89mm]

50 sccm to 2 slpm approximate weight: 1.2Ib
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EMA-LP2600A

0-5slpm []97‘235]07:1”1]
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5 slpm to 20 slpm approximate weight: 6.4 Ib.
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40 slpm approximate weight: 9.0 Ib.
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EMA-LP2600A
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[20.32mm]
.800in

0.32mm]
.800in
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P! T T} [
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50 slpm to 250 slpm approximate weight: 9.0 Ib.
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500 slpm approximate weight: 11.0 Ib.
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Technical Data for FMA-2600A-P & FMA-2600A-P-LSS Mass Flow Controllers
0 to 0.5 sccm Full Scale through 0 to 20 slpm Full Scale

The FMA-2600A-P mass flow controller is designed for applications that require tight shut-off

such as vacuum coating and sputtering

rocesses. An integrated pneumatic shut-off valve is

normally closed and provides positive shut-off of 1 x 10 atm scc/sec Helium max.
FMA-2600A-P-LSS controllers are for use with some aggressive gases (page 64).

Standard Specifications (Contact Omega for available options.)

Performance

Accuracy at calibration conditions

FMA-2600A-P-LSS Mass Flow
Controller

+ (0.8% of Reading + 0.2% of Full Scale)

FMA-2600A-P Mass Flow Controller

after tare
High Accuracy at calibration + (0.4% of Reading + 0.2% of Full Scale)
conditions after tare High Accuracy option not available for units ranged under 5 sccm.

Repeatability

+0.2% Full Scale

Zero Shift and Span Shift

0.02% Full Scale / °Celsius / Atm

Operating Range / Turndown Ratio

0.5% to 100% Full Scale / 200:1 Turndown ‘ 1% to 100% Full Scale / 100:1 Turndown

Maximum Controllable Flow Rate

102.4% Full Scale

Typical Response Time

100 ms (Adjustable)

Warm-up Time

<1 Second

Integrated Valve Leak Integrity

1 x 10 atm scc/sec Helium max

Operating Conditions

Mass Reference Conditions (STP)

FMA-2600A-P-LSS Mass Flow
Controller
25°C & 14.696 psia (standard — others available on request)

FMA-2600A-P Mass Flow Controller

Operating Temperature

-10 to +50 °Celsius

Humidity Range (Non—Condensing) 0 to 100%
Maximum Pressure 145 psig
Mounting Attitude Sensitivity None
Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials

FMA-2600A-P:303 & 302 Stainless Steel,FKM, Heat Cured Silicone Rubber, Glass Rein-
forced Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Brass, 430FR Stainless
Steel, Silicon, Glass.

FMA-2600A-P-LSS: 316LSS, 303SS, 430FRSS, Perfluoroelastomer standard, FKM,
EPDM, Buna, Neoprene as needed for some gases.

If your application demands a different material, please contact Omega.

Communications / Power

Monochrome LCD Display with
integrated touchpad

FMA-2600A-P & FMA-2600A-P-LSS Mass Flow Controller

Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal' Options

RS232 Serial / RS485 Serial

Analog Input/Output Signal? Options

0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA

Optional Secondary Analog

0-5 Vdc / 1-5 Vdc / 0-10 Vdc / 4-20 mA

Input/Output Signal?
Electrical Connection Options 8 Pin Mini-DIN / 15-pin D-sub (DB15)
Supply Voltage 12 to 30 Vdc (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.250 Amp

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature
2. The Analog Output Signal and Optional Secondary Analog Output Signal communicate your choice of Mass
Flow, Volumetric Flow, Pressure or Temperature

Range Specific Specifications

Full Scale Mass Flow Controller
FMA-2600A-P 0.5SCCM to 20SLPM

Mechanical Dimensions
4.8"Hx 6.8"W x 1.5"D

Process Connections
1/4” VCR® Male

FMA-2600A-P-LSS 0.5SCCM to 20SLPM

5.5"Hx 6.8"W x 1.5"D 1/4” VCR® Male

Welded VCR® process connections are recommended for FMA-2600A-P and FMA-2600A-P-LSS applications.

Please contact Omega.
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EMA-2600A-P [141.73mm]
All ranges [9.53mm] 5.580in
.375in [6.10mm]
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FMA-2600A-P approximate weight: 3.0 Ib.
FMA-2600A-P-LSS
All ranges L1 .73mm}
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i 4X .240in THRU
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FMA-2600A-P-LSS approximate weight: 3.2 Ib.
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Technical Data for FMA-2600A-LSS Mass Flow Controllers

FMA-2600A-LSS instruments are built for use with aggressive gases. For the
most part, these instruments maintain the specifications of equivalently ranged

FMA-2600A devices.

Standard Compatible Gas List for FMA-2600A-LSS Controllers

0 Air Air 23 | 98% Ar [/ 2% CO2 C-2

1 Argon Ar 24 | 75% CO2 / 25% Ar C-75
2 Methane CH4 25 | 75% Ar / 25% He A-75
3 | Carbon Monoxide co 26 | 75% He / 25% Ar A-25
4 Carbon Dioxide co2 90% He / 7.5% Ar /

5 Ethane C2H6 27 2.5% CO2 A1025
6 Hydrogen H2 Helistar® A1025

7 Helium He 90% Ar / 8% CO2 /

8 Nitrogen N2 28 2% 02 Star29
9 Nitrous Oxide N20 Stargon® CS

10 Neon Ne 29 | 95% Ar /5% CH4 P-5
11 Oxygen 02 30 Nitric Oxide NO
12 Propane C3H8 31 | Nitrogen Triflouride NF3
13 normal-Butane n-C4H10 32 Ammonia NH3
14 Acetylene C2H2 34 | Hydrogen Sulfide H2S
15 Ethylene C2H4 36 Propylene C3H6
16 iso-Butane i-C4H10 In addition, the following gases are
17 Krypton Kr available upon request:

18 Xenon Xe Nitrogen Dioxide to 0.5% NO2
19 | Sulfur Hexafluoride SF6 in an inert carrier

20 | 75%Ar [/ 25% CO2 C-25 Refrigerant gases to 100%

21 | 90% Ar/10% CO2 c-10 Other gases to 1000 ppm in an inert
22 | 92% Ar / 8% CO2 C-8 carrier

If your application requires another gas or gas mixture, please contact Omega.

Please refer to the Technical Data and Specifications for the equivalently ranged

FMA-2600A instrument for all operating specifications except:

Operating Range 1% to 100% Full Scale

Turndown Ratio 100:1

Wetted Materials

FKM, EPDM as needed for some gases.

316LSS, 303SS, 430FRSS, Perfluoroelastomer standard,

The dimensions of FMA-2600A-LSS instruments may vary from their standard

FMA-2600A counterparts. Dimensional drawings for FMA-2600A-LSS
instruments are shown on pages 68 -71
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EMA-2600A-LSS
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[13.34mm] | 1/8 NPT [91.12mm]_| L [13.34mm]
-525in Both Sides 3.588in o
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100 scem to 20 slpm approximate weight: 1.2 Ib

68



EMA-2600A-LSS
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250 slpm approximate weight: 9.0 Ib.
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EMA-2600A-LSS
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3000 slpm approximate weight: 12.0 Ib.
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Eight Pin Mini-DIN Connector Pin-Outs

If your FMA-2600A instrument was ordered with the standard Eight Pin Mini-
DIN connection, please be sure to reference the following pin-out diagram.

Standard 8 Pin Mini-DIN Pin-Out

Pin | Function Mini-DIN
cable color

1 |Inactive (or optional 4-20mA Primary Output Signal) Black

) Static 5.12 Vdc [or optional Secondary Analog Output (4-20maA, Brown
5Vdc, 10Vdc) or Basic Alarm]

3 | Serial RS232RX / RS485(-) Input Signal (receive) Red

4 Meters = Remote Tare (Ground to Tare) Orange
Controllers = Analog Set-Point Input

5 | Serial RS232TX / RS485(+) Output Signal (send) Yellow
0-5 Vdc (or optional 0-10 Vdc) Output Signal Green

7 |PowerIn Blue
Ground (common for power, digital communications, analog signals

8 Purple
and alarms)

Note: The above pin-out is applicable to all the flow meters and controllers with the
Mini-DIN connector. The availability of different output signals depends on the options
ordered. Optional configurations are noted on the unit’s calibration sheet.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-FMA-2600A Series DB15 wire to a DB15 equipped FMA-2600A Series. Not
all features may be available between brands, but the common denominators are featured in
our DB15 offerings, along with some options for customization.

DB15

O0O0OO0O00C0O0
O 000QOQ

Male Connector Front View Female Connector Front View
Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Ground
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C
8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)
9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 RS232 RX (receive) or RS485 —
14 Ground
15 RS232 TX (send) or RS485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 3, 9, 10, and 14 are connected together inside of the device and are
common grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-FMA-2600A Series DB15 wire to a DB15 equipped FMA-2600A Series. Not
all features may be available between brands, but the common denominators are featured in
our DB15 offerings, along with some options for customization.

DB15A (XFM)

Male Connector Front View Female Connector Front View
Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*
4 Ground
5 Power Supply Common
6 Ground
7 Power Supply (+Vdc)
8 RS232 Tx (send) / RS485 —
9 Ground
10 N/C
11 N/C
12 Secondary Analog Signal Output / fixed 5.12Vdc*
13 N/C
14 N/C
15 RS232 Rx (receive) / RS485 +

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 4, 5, 6 and 9 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on FMA-2600A devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-FMA-2600A Series DB15 wire to a DB15 equipped FMA-2600A Series. Not
all features may be available between brands, but the common denominators are featured in
our DB15 offerings, along with some options for customization.

DB15B

EERAT

Male Connector Front View Female Connector Front View
Pin Number Function
1 Ground
2 Primary Analog Signal Output
3 N/C
4 N/C
5 Power Supply (+Vdc)
6 N/C
7 N/C
8 Analog Tare (meters — when grounded)*
Analog Set-Point Input (controllers)*
9 Power Supply Common
10 Ground
11 Secondary Analog Signal Output / fixed 5.12Vdc
12 N/C
13 N/C
14 RS232 RX (receive) or RS485 —*
15 RS232 TX (send) or RS485 +*

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory)
* Added to allow for full use of features on FMA-2600A devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-FMA-2600A Series DB15 wire to a DB15 equipped FMA-2600A Series. Not
all features may be available between brands, but the common denominators are featured in
our DB15 offerings, along with some options for customization.

DB15K

o ®w

Male Connector Front View Female Connector Front View

Pin Number Function

1 N/C

2 Primary Analog Signal Output

3 N/C

4 N/C

5 Power Supply Common

6 N/C

7 Power Supply (+Vdc)

8 Analog Tare (meters — when grounded)

Analog Set-Point Input (controllers)

9 Secondary Analog Signal Output / fixed 5.12Vdc *

10 N/C

11 Ground

12 Ground

13 RS232 RX (receive) or RS485 — *

14 RS232 TX (send) or RS485 + *

15 Ground
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on FMA-2600A devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-FMA-2600A Series DB15 wire to a DB15 equipped FMA-2600A Series. Not
all features may be available between brands, but the common denominators are featured in
our DB15 offerings, along with some options for customization.

DB15H

eI

Male Connector Front View Female Connector Front View
Pin Number Function

1 N/C

2 RS232 RX (receive) or RS485 — *

3 N/C

4 N/C

5 Ground

6 Primary Analog Signal Output

7 Power Supply Common

8 N/C

9 N/C

10 Secondary Analog Signal Output / fixed 5.12Vdc *

1 Power Supply (+Vdc)

12 Ground

13 N/C

14 Analog Tare (metgrs — when grounded)
Analog Set-Point Input (controllers)

15 RS232 TX (send) or RS485 + *

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 5, 11, 12 and 15 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on FMA-2600A devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement
when connecting a non-FMA-2600A Series DB15 wire to a DB150 equipped FMA-2600A
Series. Not all features may be available between brands, but the common denominators are
featured in our DB15 offerings, along with some options for customization.

DB150

Male Connector Front View Female Connector Front View
Pin Number Function

1 Ground

2 N/C

3 N/C

4 Primary Analog Signal Output

5 Power Supply (+Vdc)

6 N/C

7 Analog Tare (meters — when grounded)*

Analog Set-Point Input (controllers)*

8 N/C

9 Power Supply Common

10 Ground

11 Secondary Analog Signal Output / fixed 5.12Vdc

12 N/C

13 N/C

14 RS232 RX (receive) or RS485 —*

15 RS232 TX (send) or RS485 +*
Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.
NOTE: Pins 1, 9, and 10 are connected together inside of the device and are common
grounding points.
N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory)
* Added to allow for full use of features on FMA-2600A devices, may not be present on host wiring.
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DB15 Pin-Outs

If your instrument was ordered with a DB15 connection, be sure to check the
Calibration Label on the device and reference the appropriate pin-out diagram.

The following pin-out chart describes the safest and generally compatible arrangement when
connecting a non-FMA-2600A Series DB15 wire to a DB15 equipped FMA-2600A Series. Not
all features may be available between brands, but the common denominators are featured in
our DB15 offerings, along with some options for customization.

DB15S

& @ G (D)W

Male Connector Front View Female Connector Front View
Pin Number Function

1 Ground

2 Primary Analog Signal Output

3 N/C

4 N/C

5 Ground

6 N/C

7 N/C

8 Analog Tare (meters — when grounded)
Analog Set-Point Input (controllers)

9 Power Supply Common

10 Ground

11 Secondary Analog Signal Output / fixed 5.12Vdc *

12 RS232 RX (receive) or RS485 — *

13 Power Supply (+Vdc)

14 RS232 TX (send) or RS485 + *

15 Ground

Check your device’s calibration certificate and user manual for the actual electrical input/
output requirements, as all instruments are custom configured to some extent.

NOTE: Pins 1, 5, 9, 10 and 15 are connected together inside of the device and are common
grounding points.

N/C = Not Connected/Open (can be used for custom pin assignments — please consult factory).
* Added to allow for full use of features on FMA-2600A devices, may not be present on host wiring.
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WARRANTY/DISCLAIMER

OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and
workmanship for a period of 13 months from date of purchase. OMEGA’s WARRANTY adds
an additional one (1) month grace period to the normal one (1) year product warranty to
cover handling and shipping time. This ensures that OMEGA’s customers receive maximum
coverage on each product.

If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer
Service Department will issue an Authorized Return (AR) number immediately upon phone
or written request. Upon examination by OMEGA, if the unit is found to be defective, it
will be repaired or replaced at no charge. OMEGA’'s WARRANTY does not apply to defects
resulting from any action of the purchaser, including but not limited to mishandling, improper
interfacing, operation outside of design limits, improper repair, or unauthorized modification.
This WARRANTY is VOID if the unit shows evidence of having been tampered with or shows
evidence of having been damaged as a result of excessive corrosion; or current, heat, moisture
or vibration; improper specification; misapplication; misuse or other operating conditions
outside of OMEGA's control. Components in which wear is not warranted, include but are not
limited to contact points, fuses, and triacs.

OMEGA is pleased to offer suggestions on the use of its various products. However,
OMEGA neither assumes responsibility for any omissions or errors nor assumes
liability for any damages that result from the use of its products in accordance
with information provided by OMEGA, either verbal or written. OMEGA warrants
only that the parts manufactured by the company will be as specified and free of
defects. OMEGA MAKES NO OTHER WARRANTIES OR REPRESENTATIONS OF ANY
KIND WHATSOEVER, EXPRESSED OR IMPLIED, EXCEPT THAT OF TITLE, AND ALL
IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION
OF LIABILITY: The remedies of purchaser set forth herein are exclusive, and the
total liability of OMEGA with respect to this order, whether based on contract,
warranty, negligence, indemnification, strict liability or otherwise, shall not exceed
the purchase price of the component upon which liability is based. In no event shall
OMEGA be liable for consequential, incidental or special damages.

CONDITIONS: Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1)
as a “Basic Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or
activity; or (2) in medical applications or used on humans. Should any Product(s) be used in or
with any nuclear installation or activity, medical application, used on humans, or misused in
any way, OMEGA assumes no responsibility as set forth in our basic WARRANTY/DISCLAIMER
language, and, additionally, purchaser will indemnify OMEGA and hold OMEGA harmless from
any liability or damage whatsoever arising out of the use of the Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department.
BEFORE RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN
AUTHORIZED RETURN (AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT
(IN ORDER TO AVOID PROCESSING DELAYS). The assigned AR number should then be
marked on the outside of the return package and on any correspondence.

The purchaser is responsible for shipping charges, freight, insurance and proper packaging to
prevent breakage in transit.

FOR WARRANTY RETURNS, please have FOR NON-WARRANTY REPAIRS, consult
the following information available BEFORE OMEGA for current repair charges. Have the
contacting OMEGA: following information available BEFORE
1. Purchase Order number under which contacting OMEGA:
the product was PURCHASED, 1. Purchase Order number to cover the
2. Model and serial number of the product COST of the repair,
under warranty, and 2. Model and serial number of theproduct, and
3. Repair instructions and/or specific 3. Repair instructions and/or specific problems
problems relative to the product. relative to the product.

OMEGA'’s policy is to make running changes, not model changes, whenever an improvement is possible.
This affords our customers the latest in technology and engineering.

OMEGA is a trademark of OMEGA ENGINEERING, INC.

© Copyright 2018 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied,
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without
the prior written consent of OMEGA ENGINEERING, INC.



Where Do | Find Everything | Need for
Process Measurement and Control?
OMEGA...Of Course!

Shop online at omega.com

TEMPERATURE

=4 Thermocouple, RTD & Thermistor Probes, Connectors, Panels & Assemblies
¥ Wire: Thermocouple, RTD & Thermistor

[ Calibrators & Ice Point References

[F Recorders, Controllers & Process Monitors

[ Infrared Pyrometers

PRESSURE, STRAIN AND FORCE
¥ Transducers & Strain Gages

¥ Load Cells & Pressure Gages

[ Displacement Transducers

[ Instrumentation & Accessories

FLOW/LEVEL

¥ Rotameters, Gas Mass Flowmeters & Flow Computers
¥ Air Velocity Indicators

¥ Turbine/Paddlewheel Systems

[ Totalizers & Batch Controllers

pH/CONDUCTIVITY

(¥ pH Electrodes, Testers & Accessories

¥ Benchtop /Laboratory Meters

¥ Controllers, Calibrators, Simulators & Pumps
[ Industrial pH & Conductivity Equipment

DATA ACQUISITION

(¥ Communications-Based Acquisition Systems
[ Data Logging Systems

¥ Wireless Sensors, Transmitters, & Receivers
4 Signal Conditioners

¥ Data Acquisition Software

HEATERS

(¥ Heating Cable

[ Cartridge & Strip Heaters
¥ Immersion & Band Heaters
& Flexible Heaters

[ Laboratory Heaters

ENVIRONMENTAL
MONITORING AND CONTROL

¥ Metering & Control Instrumentation

A Refractometers

¥ Pumps & Tubing

¥ Air, Soil & Water Monitors

[ Industrial Water & Wastewater Treatment

¥ pH, Conductivity & Dissolved Oxygen Instruments M3791/0118





